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Intro

Hello and thank you for buying the MixPre-3!  At Sound Devices, we are freaks 
about audio.  We’ve unleashed our design and engineering team (most of 
whom are musicians) and let them create a device that we want to own our-
selves.  We think that you’ll find the unique mix of performance, ease-of-use, 
design and build quality to be an invaluable part of your life and creative pas-
sion for many years to come.

The MixPre-3 has been meticulously-engineered to offer extreme flexibility and 
sound quality, operating in three basic ways:
• 3 mic/line input, 2 channel output mixer with our exclusive Kashmir™ dis-

crete mic preamplifiers with user-selectable analog limiters and low-cut 
filters.

• SD card recording and playback of individual channels and the main mix 
simultaneously at 44.1, 48, 96 kHz, 16, 24-bit files.

• 5-in, 2-out USB computer audio interface

The possible uses for the MixPre-3 are virtually unlimited, but a few common 
ones might be:
• Paired with a DSLR camera recording high-quality audio for video, complete 

with timecode and HDMI record triggering.
• Podcast or music recording using up to three high-quality voice-over micro-

phones (or other sources) interfacing via USB to a computer. 
• Stand-alone audio recorder for House-of-Worship, mixing a direct feed from 

the PA system with a stereo feed of ambient congregational response, sing-
ing and music from a stereo microphone.

The MixPre-3’s application flexibility is augmented by the various powering 
options.  Whether you wish to power the MixPre-3 from a USB connection, AA 
batteries, L-mount batteries or an optional AC wall plug adapter, it’s ready, will-
ing and able to go anywhere, anytime - always handling your audio needs with 
grace.

We’ve designed the MixPre-3 to be easy to use for the novice without taking 
away truly professional-level features for the seasoned pro user.  With that in 
mind, the MixPre-3 ships from the factory in Basic mode - this is ideal for less 
experienced users and will satisfy the majority of audio applications. If you 
want to dive straight into the full array of professional features, we recommend 
setting to Advanced mode. See Modes and Presets for more information.

We sincerely hope that you enjoy working with the MixPre-3 as much as we’ve 
enjoyed creating it!  Please drop us an email at support@sounddevices.com and 
share your experiences as we’d love to see how the MixPre-3 is furthering your 
passion!
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Powering

Flexible Powering Options

In designing the MixPre-3, we felt that it was important for it to be able to op-
erate in a wide array of applications and environments.  To support that goal, 
power can be supplied from several possible sources.  Some possible powering 
scenarios are:

• Four AA alkaline or NiMH rechargeable batteries installed in the provided 
4-AA battery sled.

• Eight AA alkaline or NiMH rechargeable batteries installed in the optional 
8-AA battery sled accessory.

• One or two Sony-type L-mount batteries installed in the optional L-mount 
battery sled accessory.

• USB-C to USB-C cable connected to a USB-C host computer or AC wall 
adapter.

• USB-A to USB-C cable connected to a USB-A host computer or AC wall 
adapter.

• Dual USB-A to USB-C cable (included) connected to a USB-A host computer.  
Use this cable option if your computer is unable to provide adequate power 
for the MixPre-3 with only one USB-A port.

• Optional MX-CHARGE AC wall adapter to USB-C power supply.

The master power switch for the MixPre-3 is located in the upper right corner of 
the left side panel.

Power Switch
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To preserve battery power, USB-C power sources take priority over batteries if 
both are connected with one exception - if the USB-C power source does not 
meet the full power requirements of the MixPre-3, you can choose to power 
from battery or continue to power from USB-C. We have designed the MixPre-3 
so that even with an under powered USB-C source, you will still be able to use 
two of the three channels with 48V phantom mics. The third channel can still be 
used with dynamic mics and line, aux, or USB sources. To achieve this we auto-
matically do the following:
• Dim LCD and LED Brightness 
• Disable USB-A port 
• Disable HDMI TC port

For protection against accidental loss of power (not something you particularly 
want to happen during recording), the MixPre-3 incorporates circuitry to auto-
matically switch over from USB-C to batteries if the USB-C power source acci-
dentally gets pulled.



9

Rev#

Panels

Front Panel

Power light, Recorder transport controls, Channel knobs, Channel knob ring 
LEDs, Touch screen

Recorder Transport Controls

Channel Knobs
Channel Knob Ring LEDs

Power Light

LCD

Left Side Panel

USB connections, XLR inputs 1-2, 3.5mm stereo output, Power switch

Power SwitchUSB-A Port

XLR Inputs 3.5 mm Stereo Output

USB-C Port
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Right Side Panel

3.5mm headphone output, 3.5mm Mic/Aux input, XLR input 3, 

Headphone volume encoder, HDMI TC input

HDMI TC InputHP Encoder

XLR Input3.5 mm Headphone  Output 3.5 mm Aux/Mic Input

Back Panel

Battery mounts, SD memory card slot, Allen wrench (for ¼-inch-20-thread cap-
tive screw), anti-rotational pin

SD Memory Card Slot

Battery Mounts

Allen wrench & anti-rotational pin
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Touch Screen

The MixPre-3 has a sunlight-viewable, high-resolution, touch-screen-based user 
interface, which consists of the Home screen, Main Menu screen, and Channel 
screen views.  As you will notice, there are several touch zones on the touch 
screen for controls.  As you become familiar with the user interface, changing 
settings for inputs, outputs, recording and metering will become fast and intui-
tive.

Current File Name
Power Status Icon

Menu Icon

SD Card Remaining Record Time Current Headphone Preset

Time Counter

File List Icon

Meter View

Home Screen

The Home screen view is the default view that appears on the touch screen 
when the device is powered up.  On it, you will find items such as:
• File list icon and current file name
• File elapsed time counter (timecode if LTC or HDMI timecode is enabled) 
• Power status icon

Power StatuS Icon DeScrIPtIon

 
(Green USB)

USB power source is ideal.

 
(Orange USB)

USB power source low. Brightness dimmed, HDMI & USB-A 
ports disabled, 48v phantom on 2 channels only.

 
(Green Battery)

Healthy battery. Plan to change batteries when green level 
drops to about ¼ full.

 
(Flashing Red Battery)

Battery power is critically low. Change batteries.

• Menu icon
• Meter view (cycle views by touching)

 ◦ Two channel mix track meters
 ◦ Two channel mix track meters, three individual track view
 ◦ Two channel mix track meters, two USB input meters, two aux input me-
ters
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• Status bar
 ◦ SD card available recording time
 ◦ Headphone preset
 ◦ Sample rate and bit depth
 ◦ Date and time

Main Menu Screen

The Menu screen is where most of the features and functions are selected and 
set up.  

To enter the Menu screen:

 X Tap  on the Home screen. 

There are three Menu screen views.  These views are indicated by the Dots icon 

. Tapping it will toggle between the three Menu views.

  

The Menu has its own submenus that may be displayed by tapping them. 

To return to the main Menu from a submenu at any time:

 X Tap . 

To return directly to the Home screen from the main Menu:

 X Tap .
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Page Sub-menu DeScrIPtIon

1 Presets Lets you save and recall preset user settings to and from SD cards 
and internal memory. Also allows resetting all settings to factory 
default.

1 Project Provides the ability to create new, open and trash existing projects.
1 Inputs Provides settings for the Aux/Plug-in-power Mic/Timecode input/

Camera.
1 Outputs* Provides routing and gain settings for the stereo output. 
2 Timecode* Lets you select timecode mode. 
2 Tone Provides test tone settings.
2 Record** Provides record settings for LR mix gain, sample rate, bit depth, LR 

linking, and HDMI record trigger.
2 SD Card Displays current SD card information and allows for format and 

empty trash card functions.
3 Date/Time Sets current date/time and format.
3 System Provides settings for Basic/Advanced/Custom mode, Custom mode 

setup, limiters, USB-C, File Transfer, Bluetooth®, Wingman App 
password, adjusting LCD/LED brightness, updating firmware, and 
viewing version and regulatory information. 

3 Power Select the type of batteries being used (Alkaline, NiMH, L-Mount) to 
ensure that the Power Status icon on the Home screen accurately 
displays remaining battery level.

*Sub-menu/setting appears in Advanced mode only
** Some Record sub-menu options are only available in Advanced mode

Channel Screen

The Channel screen is where you will find channel-specific settings, such as 
Channel name, Input selection, Pan, 48v phantom power and Low Cut filtering.

 

In Advanced mode, additional settings are available via a second channel page 
accessed by tapping the Dots icon. 

 L The top left corner of the Channel screen displays an editable Channel name. 
Touch this region to give the channel an easy to identify name, like Vocals or Bob. 
Below the Channel name is a Channel meter to aid in setting audio levels.
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Page Sub-menu DeScrIPtIon

1 Solo* Lets you solo the selected channel in the headphone output. Soloing 
by default is Individual (exclusive) in that only one input at a time 
will be soloed.  When a channel is soloed, its light ring will flash 
orange. Soloing can be set to Multiple (non-exclusive) in the HP 
Preset submenu.

1 Arm* Allows pre-fade recording of the channel to its own isolated (ISO) 
track on the SD card.

1 Gain* Sets the sensitivity of the input. Generally, the gain should be set so 
that the loudest parts of the audio signal just touch the red seg-
ments of the meters.

1 Pan Lets you position the channel’s audio in the stereo image of the LR 
mix and stereo out. 

2 Input Lets you select one of the available Mic, Line, or USB inputs to route 
to the chosen channel.

2 Phantom Lets you apply full 48v phantom power to the channel’s mic or line 
input.

2 Low Cut Sometimes referred to as a high pass filter (HPF), the Low Cut filter 
can be set up to roll off bass frequencies or reduce mic handling 
noise, wind noise, and other undesirable low frequencies. The filter 
has a carefully crafted 18 dB/octave slope.

2 Linking* Lets you link channels 1 and 2, either as a stereo pair or mid-side 
pair.

* Sub-menu/setting appears in Advanced mode only

To enter the Channel screen:

 X Press the associated Channel knob.
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Modes and Presets

Setting the Mode

We’ve designed the MixPre-3 to be easy to use for the novice without taking 
away truly professional-level features for the seasoned pro user.  We want both 
the newcomer and the career professional to enjoy a quick, easy setup and 
foolproof results.  To accommodate this, we’ve incorporated three modes of op-
eration into the MixPre-3: Basic, Advanced and Custom.

To set the mode:

1. Turn all channel knobs to Off (at full counter-clockwise position). 

2. Tap .

3. Tap System > Mode. Options include: Basic, Advanced, and Custom.

Basic Mode

Basic mode is intended for hassle-free, plug-and-play use.  This mode is ideal 
for the new user and amateur needing only the basic functionality of the Mix-
Pre-3.

Screen Sub-menu DeScrIPtIon

Menu Presets Save and load user presets to and from SD card and internal 
memory. Also allows resetting all settings to factory default.

Menu Project Create new projects, or open and trash existing projects.
Menu Inputs Provides settings for the 3.5 mm Aux/Mic In.
Menu Timecode Select Time of Day or HDMI TC from a DSLR as timecode 

source. Off is also an option.
Menu Tone Turn the test tone on or off. By default, the test tone is a 1kHz 

sine wave at -20dBFS.
Menu Record Choose to auto start/stop recording via HDMI from a DSLR.
Menu SD Card Displays SD card info and allows for formatting SD cards and 

and emptying their trash folder.
Menu Date/Time Sets current date/time and format.
Menu System Provides settings for Basic/Advanced/Custom mode, Custom 

mode setup, limiters, USB-C, File Transfer, Bluetooth®, Wing-
man App password, adjusting LCD/LED brightness, updating 
firmware, and viewing version and regulatory information.

Menu Power Select the type of batteries being used (Alkaline, NiMH, 
L-Mount) to ensure that the Power Status icon on the Home 
screen accurately displays remaining battery level.

Menu HP Preset Select LR Stereo or USB 1,2 as headphone sources.
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Screen Sub-menu DeScrIPtIon

Channel Pan Pan the channel’s signal Left, Center or Right in the stereo LR 
mix and Stereo Out.

Channel Input Select one of the available Mic, Line, Aux (only available if Aux 
In Mode is Mic or Line) or USB inputs to route to the selected 
channel.

Channel Phantom Turn on 48V phantom power when using a condenser micro-
phone in the selected channel.

Channel Low Cut Select the frequency at which a low cut filter will be placed.  
The filter has a carefully-crafted 18db/octave slope. Low op-
tions are only On/Off in Basic mode.

Advanced Mode

Advanced mode is intended for use by professionals and users who wish to have 
every available setting and option at their disposal.  All settings available to Ba-
sic Mode apply to Advanced Mode in addition to:

Screen Sub-menu DeScrIPtIon

Menu Outputs Provides routing and gain settings for the Stereo Out.
Menu Tone Provides additional Tone mode (Continuous and Left Identify) 

and Tone Level settings.
Menu Record Provides additional record settings for gain, sample rate, bit 

depth and LR linking.
Menu HP Preset Provides additional HP presets for LR Mono, User Presets 1-4, 

Edit HP Preset utility and HP Solo mode selection. Camera Ste-
reo and Camera Mono are also available when Aux In Mode is 
set to Camera.

Menu System > 
Limiters

Lets you turn limiters on or off.

Channel Solo Lets you “solo” the selected channel in the headphone output.  
Solo mode can be set to “Individual” or “Multiple” in the HP 
Preset menu.  When a channel is soloed, its light ring will flash 
orange.

Channel Arm Allows pre-fade recording of the channel to an individual track 
on the SD card.

Channel Gain Sets the sensitivity of the input.  Generally, the Gain should be 
set so that the loudest parts of the audio signal just touch the 
red segments of the meters.

Channel Pan Lets you position the audio of the channel anywhere between 
Left and Right in the stereo image of the LR mix and Stereo 
Out.

Channel Linking Lets you link channels 1 and 2 either as a stereo pair, mid side 
pair, or turn linking off.
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Custom Mode

Custom mode is intended for users who want to customize the features and 
functionality available to them.  This mode grants access to different sections of 
Advanced Mode features, turning them on or off in the user interface as desired.

To configure Custom Setup:

1. Tap .

2. Tap System > Custom Setup.

Custom Setup options are:

Page Sub-menu DeScrIPtIon

1 Channel Lets you access Solo, Track Arm, extended Pan, Input Select, 
Phantom and Low Cut, which is selectable by frequency.

1 Gain Lets you access to Channel Gain controls.
1 Headphone Lets you access extended headphone source select options in-

cluding factory and user headphone presets, preset editing and 
Solo setup for Individual/Multiple channels.

1 Record Provides additional record settings for gain, sample rate, bit 
depth and LR linking.

2 Metadata Adds ability to change track name, rename files, add notes and 
undo recordings.

2 Outputs Provides routing and gain settings for the Stereo Out.

User Presets

Flexibility is the MixPre-3’s M.O.  To make it easy for you to use the MixPre-3 in 
a wide variety of situations, we created a slick feature where you can store and 
recall snapshots of all of the MixPre-3’s settings.  There are four internal Preset 
slots available.  Also, the SD card can store virtually unlimited Presets.

Here are three common examples:
• You might want to use the MixPre-3 as recorder, mixer, and USB audio in-

terface in a podcasting rig with specific microphones.  
• The next day, you need to have the MixPre-3 handle audio duties for you 

while you’re shooting video on your DSLR camera.  
• On Sunday, you might need to use your trusty MixPre-3 to record worship 

services, mixing a direct line from the PA with a stereo microphone feed.  
Using Presets, you can optimize settings for each of these scenarios and then 
simply save each setup to one of four internal preset locations or to the SD 
card.  Once saved, simply load the appropriate preset and BOOM! You’re ready 
to go in a jiffy!  We think that you’ll really appreciate this functionality.
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To save a Preset:

1. Tap .

2. Tap Presets > Save to Internal 1-4 or SD Card

3. Enter a Preset Name and tap OK.

To recall a Preset

1. Tap .

2. Tap Presets > Load Preset.

3. Select preset with encoder.

4. Tap OK.
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Inputs

The MixPre-3’s flexibility is enhanced by its ability to select various input types 
to its mixer channels.  Each of the MixPre-3’s channels can be sourced from an 
XLR mic/line input, 3.5mm Aux or PiP (Plug in Power) Mic input or from either 
of the two USB audio paths from a computer. 

Channel Inputs

BASIC MODE - 

For quick and easy applications, access the channel’s input settings by 
pushing the desired channel’s channel knob.  You will see the Channel 
screen displayed.  

There, you’ll be able to select the channel input source, whether you’d like 
to send the audio to the Left, Center or Right in the mix bus and Stereo 
out, select Phantom power (for condenser microphones and active DIs), 
and select a Low Cut filter.  The MixPre-3’s Kashmir mic preamplifiers have 
extreme dynamic range and noise specs as well as analog limiters so it’s 
not necessary for you to set any levels other than that of the Channel knob, 
which sends the audio to the LR mix record channels and the Stereo Out.  
The limiters are present on each channel and the LR mix bus. This means 
that peaks that would normally clip other mic preamplifiers and ruin a mix, 
will be handled in just the right way to make sure that your audio is safe 
from accidental clipping both on the Stereo Outs and the recorder.

ADVANCED MODE - 

For more complex situations requiring individual channel-to-track recording, 
soloing, channel linking and extended gain functionality and limiter bypass.
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Are you working with a stereo source—a keyboard or stereo mic perhaps?  
To make it easy to adjust these types of sources, the MixPre-3 offers linking 
of channel pairs 1-2. 

To link channels 1-2:

1. Push the channel knob 1 to access that Channel screen.

2. Tap Linking.

Do one of the following:
 X Select 1-2 for a stereo source.
 X Select 1-2ms for MS (Mid-Side) source.  

You’ll now be able to control the level of both channels 1 and 2 with the 
channel 1 knob.  The channel 2 knob will now function as a balance control 
if stereo linked or as a width control if MS linked.

MS Decoder

You can choose to have the MS decoder apply to the mix only and not isolated 
tracks. 

To set MS Decode:

1. Tap .

2. Tap Inputs > MS Decode. Options include: ISO & Mix or Mix Only.

Inputs Menu

The Inputs menu, which is accessed through the Main Menu, allows you to con-
figure how the Aux/Mic In 3.5mm connector is to be used. 

Tap Aux In Mode to select one of the following options:
• Mic: Select this option when the Aux/Mic In is to be used with a plug-in-

power mic.
• Line: Select this option when the Aux/Mic In is to be used with an un-

balanced 2ch line source e.g. smartphone headphone output, stereo line 
source etc.
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When either the Mic or Line options above are selected as the Aux In Mode, 
they are available as input sources to any channel by selecting Aux In 1 or 
Aux In 2.

• Camera: Select this option when the Aux/Mic In is to be used for monitor-
ing a video camera’s audio output via the MixPre-3’s headphones and C1/C2 
meters located on meter view 3.

This is particularly useful when you want to use the MixPre-3 to drastical-
ly improve the sound quality recorded on the DSLR camera. It is common 
knowledge that DSLR mic inputs are of poor quality so by connecting your 
mics to the MixPre-3 instead, then connecting the MixPre-3’s stereo out-
put to your camera audio input, you will achieve far superior sound quality. 
Then by connecting the camera’s audio output to the MixPre-3’s Aux/Mic In, 
it allows you to check that the camera audio is noise and distortion-free.

When this option is selected an additional setting appears in the Input Menu 
called Camera Gain. This allows you to adjust the gain of the incoming cam-
era audio level.

You also gain camera monitoring options in the HP Presets menu.
• Timecode (only available in Advanced Mode): Select this option when the 

Aux/Mic In is to be used as a LTC (linear timecode) input. When selected as 
a timecode input, Aux In 1 and Aux In 2 become available as options for TC 
Mode (located in Timecode Menu)

 L When Aux In Mode is set to Camera or Timecode, you cannot route Aux In to a 
channel and thus you cannot record it.

• Off: Select this option to turn off the Aux/Mic Input.
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Outputs

While we were carefully thinking about how to maximize flexibility with the in-
puts, we were doing the same with the outputs!  

Stereo Outs

The Outputs menu is available in Advanced mode and accessed through the 
Main Menu.  In the Outputs menu, you may send any channel, aux input, USB 
input or LR mix to either or both of the Stereo Outs.  In addition, if you choose 
to send the channels to outputs, you can select either pre-fade (channel knob 
has no effect) or post-fade (channel knob controls level).  In addition to rout-
ing options, the Outputs sub-menu also provides gain adjustment of the Stereo 
Outs. Range is: Off, -40 to +20dB.

Output Muting

On the MixPre-3, the 3.5mm stereo output may be muted. 

To mute outputs:

1. Tap .

2. Tap Outputs.

3. Tap St Out Mute.

This toggles Mute on/off.

Headphone Out

The MixPre-3’s audiophile-grade headphone amplifier provides high power and 
very low noise performance so that you can accurately hear the audio being 
handled, regardless of headphones or environment.  Connect headphones via 
3.5mm jack to the headphone jack (located on the right side panel).  The vol-
ume of the headphones can be set with the encoder directly adjacent to the 
headphone jack.  

From the main Menu screen, the headphone presets (HP Presets) 
may be accessed by pressing this icon in the upper left corner of the 
screen. Above this icon, the currently selected HP preset is displayed. 

Entering the HP Presets menu, you may select from LR Stereo, LR Mono, 
USB 1, 2, and User Presets 1-4.  
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 L Options listed here are those available in Advanced mode. Only LR Stereo and 
USB 1,2 are available in Basic mode.

There’s  an Edit HP Preset utility where User HP presets may be edited and giv-
en custom names and finally a HP Solo button where the HP solo mode can be 
switched between Individual and Multiple for single or multi-channel solo moni-
toring.

Since the headphone amplifier is capable of very high output levels, please use 
caution when wearing headphones as hearing damage could result with inap-
propriate volume levels.

Combining the input/output flexibility and the User Presets feature, you’ll find 
endless uses for the MixPre-3!

Disabling Record Bells in Headphones

Record bells, heard in headphones when recording is started and stopped in Au-
dio projects, may be turned off. 

To disable the record bells:

1. Tap .

2. Tap Record > Record Bells. 

This toggles the bells on/off. They are turned on by default.
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Metering

LEDs and Meter Views

There are five basic methods for observing input and output meters on the Mix-
Pre-3.
• Channel knob ring LEDs - Each LED ring is capable of displaying green, 

orange and red colors. The brightness of the light ring tracks the level of 
the input.  Green = signal present, red = signal peaking, orange = signal 
limiting.  In addition, a channel’s ring LED will flash orange when in solo. 
 

Channel Knob Ring LEDs
LCD

 

• Channel screen meter 
 

 

• Main LR stereo meter view 
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• LR, 1-3 multi-track meter view 
 

 

• LR, Returns (via Aux In) and USB 1,2 meter view 
 

 

Switching between the three main meter views is easy—just touch the meters 
and cycle through the different views. The meters will show not only signal lev-
els, but also the current arm status of each track for the recorder and limiting 
activity for L,R and each channel.

Metering Ballistics

Audio meter ballistics is the manner in which a visual meter responds to audio 
signal levels. Peak-reading ballistics correspond to actual signal peaks, but do 
not necessarily correspond to perceived signal loudness. Peak meters, with have 
an instant attack and slow decay, are useful in digital audio workflows where 
signal overload can cause immediate distortion. Volume Units (VU) meter bal-
listics correspond closely to how the human ear perceives loudness. VU meters 
provide good visual indication of how loud a signal will be, but provides poor 
information of actual signal peaks. 

The MixPre-3 uses a combination Peak+VU ballistics for all meters, where the 
perceived loudness (or VU) is simultaneously displayed as a standard bar while 
the peak signal is displayed as a single, independent segment above the VU.
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Recording and Playback

The MixPre-3 can record up to five audio tracks at 96kHz, 24-bit to SD cards 
(SD, SDHC, or SDXC) using the industry standard .WAV file format. The re-
corded .WAV files written to SD card can be imported or played back using any 
MAC, Windows, or Linux computer installed with a compatible audio application, 
such as Pro Tools, Reaper, Cubase, Garageband, Audacity, and many, many 
more. 

You can mix and record to the SD card even when using the MixPre-3 as a USB 
audio interface. This opens up cool opportunities for recording the computer’s 
USB audio output and mixing it with other mic and line sources plugged into 
the MixPre, making it ideal for podcasting and recording interviews via Skype or 
any other VoIP application. 

This simultaneous recording/USB audio streaming capability also makes the 
MixPre ideal as a backup to a computer—highly desirable in mission critical ap-
plications where relying only on a computer might be a risk.

The recording functionality is dependant on the current operating mode, Basic 
or Advanced.

In Basic mode, the MixPre-3 functions as a two-track 48 kHz recorder. The two 
record tracks are fed by the LR mix which is driven directly by the channel knob 
gains.

In Advanced Mode, the MixPre-3 is configured as a five-channel recorder with 
user-selectable 44.1, 48, and 96kHz sample rate and 16 and 24bit depth.  The 
LR mix tracks may be recorded as well as each of the three channels as individ-
ual isolated (ISO) tracks.  Audio for the ISO tracks is recorded “prefade” mean-
ing before the channel knob gain, so any changes that are made there will only 
affect the LR mix and have no affect on the recorded ISO track levels.  This is 
particularly useful for post-production audio processing where it may be desir-
able to remix of the tracks at a later stage. 

Formatting SD Cards

SD cards must be formatted by the MixPre-3 to ensure reliable recording and 
playback. Be sure to backup any wanted audio recordings or data on the SD 
card before formatting since the formatting process erases all data on the SD 
card.

We highly recommend using Sound Devices branded SD cards as these have 
been optimized to provide the best performance. If these are not available, 
most reputable manufacturers’ cards (such as SanDisk or Delkin) that meet or 
exceed class 10 speeds are acceptable.
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To format an SD card:

1. Insert an SD card in the slot located on the rear panel.

2. Tap .

3. Tap SD Card > Edit > Format.

4. When asked to confirm the command to format the card, tap OK. 
 
Cards with a capacity of 32 GB or less will be formatted with the FAT32 file 
system. Cards with a capacity greater than 32 GB will be formatted with the 
exFAT file system.  

 L The exFAT file system is not compatible with Windows XP or Mac OS X 10.6.4 and 
lower.

Transport Controls

The three Transport controls (illuminated buttons) on the front panel are used 
to perform recording and playback functions.

FunctIon control actIon

Record

Press to begin recording a new file. The button illuminates red 
while recording is in underway. 

Stop
While recording, press once to stop recording. While in 
playback, press once to stop playback. While in standby, 
press and hold to display next name.

Play / Pause

Press to begin playback of the last file recorded or file 
currently loaded. The button illuminates green during 
playback. While in playback, press once to pause, and press 
again to resume playback. Whenever playback is paused, the 
button and the current file name will flash green.

Scrub

While playing or paused, press and hold the headphone 
encoder to enter Scrub mode. Then rotate clockwise for fast 
forward or counter-clockwise for rewind at speeds of 0x, 
1/8x, 1/4x, 1/2x, 1x, 2x, 4x, 8x and 16x. The audio is heard 
in Scrub mode up to 2x speed.

In Basic mode, only the L/R mix bus is recorded.  Recording is as easy as press-
ing the REC button.  Push the Play button to play files and the Stop button to 
stop recording or playback.  Pushing the Play button while in Play mode, initi-
ates Pause mode. The Play button as well as the current file in the display will 
flash to indicate that Pause is active.

In Advanced Mode, all channels as well as the L/R mix bus may be recorded 
individually. To record an individual channel, ensure that it is armed.  
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To arm a channel:

1. Press the channel knob.

2. Tap Arm.   
 
Armed channels are indicated in the meters view with red meter labels 
surrounding the channel number. If neighboring channels are stereo linked, 
their labels are merged to indicate that they are linked. See Channel Inputs 
for more information regarding stereo linking.

Record Menu

In Basic mode, the Rec Trigger function is used to automatically start and stop 
recording from a compatible HDMI source, such as a DSLR. This cool feature 
lets you simultaneously start recording on a DSLR and the MixPre-3 just by 
pressing the Record button on the camera, thus eliminating the possibility of 
forgetting to record audio on the MixPre-3—not something that a producer will 
take kindly to!

In Advanced mode, there are many more settings available, as shown in the 
following table:

Sub-menu DeScrIPtIon oPtIonS

Rec L,R Mix Arms L and/or R mix buses. • Off
• L
• R
• L&R
• LR Linked

Left Gain Sets the gain for the L mix. • -60 - 0 dB (1 dB increment)
Right Gain Sets the gain for the R mix.

This setting is disabled when Rec L,R Mix is 
set to LR Linked.

• -60 - 0 dB (1 dB increment)

Sample Rate The internal sample rate and sample rate 
of recorded WAV files.

The default is 48kHz.

• 44.1kHz
• 48kHz
• 96kHz

Bit Depth The bit depth of recorded WAV files.

The default is 24.

• 24
• 16

Rec Trigger Sets record triggering from either timecode 
or HDMI flags. The default is Off.

• Off
• HDMI flag
• Timecode
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Cue Points

Working with Cue Marks

The MixPre recorders use cue marks to make it easy to quicklylocate points

of interest.

To add cues marks:

X During recording, playback, or pause, tap , the Q icon at the top of

the Home screen to add a cue mark exactly at that point in the song. A

cue mark number (starting from 01 and incrementing each time a new cue

mark is added) is displayed next to the Q icon.

The MixPre automatically renumbers cue marks if one is inserted between

existing cue marks to maintain their ascending numerical order from start to

finish—01, 02, 03, etc. You may have a maximum of 99 per file.

Cues appear in numerical order in the Cue List, such as those shown in

following image. 

To access the Cue List:

1. Tap the File List Icon.

2. Use the HP encoder to select a file (or highlight a file and tap Edit).

3. Tap Cue List from menu.

Cues may be named, moved, deleted from the Cue List.

With the Musician plugin installed, they may also be used to set up as transport 
cue points for automatic punch in/out regions. You cannot rename these Play-
back or Record In/Out points. For more information about Play In, Record In/
Out, and Stop points, see Punching In/Out in the Musician Plugin chapter.

To custom name a cue mark :

1. From the Cue List, use the HP encoder to select a cue mark.

2. Tap Name and enter a new name.
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Moving Cue Marks

You can finely tune the position of cue marks in 0.1 second increments.

To move cue marks:

1. From the Cue List, use the HP encoder to select a cue mark.

2. Tap Move and rotate the HP encoder to adjust the selection in 0.1 second

increments.

Clearing & Deleting Cue Points 

You can delete cue marks and clear Play In, Record In/Out, or Stop points via

the Cue Points menu or Cue List screen. To clear all In and Out stored values: 
Tap Clr In/Out.

RECORDING AND PLAYBACK 

To clear an individual Play In, Record In/Out, or Stop point:

X Select one from the Cue List and tap Disable.

To delete a cue mark:

1. From the Cue List, select a cue mark.

2. Tap Delete.
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Pre-roll

Pre-roll will capture audio for a set amount of time before Record is pressed. 
This will capture any audio that may be missed at the beginning of a take.  The 
MixPre-3 offers up to 5 seconds of pre-roll at 48kHz. Pre-roll time decreases as 
sample rate increases. 

Setting up Pre-roll:

Navigate to Menu>Record>Pre-roll Time and use the headphone encoder or the 
up and down arrows to set your Pre-roll value. 
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USB

USB Audio Interface

The MixPre-3 has an integrated 5-in, 2-out core audio-compatible interface for 
use with a Mac or PC computer.  For PC users, the MixPre-3 will appear as a 2x2 
audio interface unless a specific ASIO driver is installed. The latest ASIO driv-
er can be downloaded at www.sounddevices.com/support/downloads. See the 
MixPre Series Downloads page.

When working with the USB audio from a host computer, it is necessary to 
route the USB 1 and USB 2 sources appropriately. Should you want to mix the 
USB audio from the host computer with live audio from the MixPre-3’s inputs 
to the LR bus, use the channel screen and select input source (Advanced mode 
only).  To hear the USB host computer audio in the headphones only, switch the 
HP preset to USB 1,2.  

The MixPre-3 is capable of recording and streaming audio to a USB host simul-
taneously.  The MixPre-3 is also capable of recording the USB audio stream out 
of a computer directly to its SD recorder.  This is an amazingly-useful feature 
for recording any computer-based audio.  See the table below detailing the Mix-
Pre-3’s channel to output assignments.

channel uSb outPut aSSIgnment

Channel 1 USB stream 1
Channel 2 USB stream 2
Channel 3 USB stream 3
Unused USB stream 4
Mix bus L USB stream 5
Mix bus R USB stream 6
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Low-latency Monitoring

We’ve worked really hard with our hardware, logic and software design teams to 
minimize latency.  We’ve found that in many scenarios, latency when monitor-
ing through a DAW (digital audio workstation) is perfectly acceptable, depend-
ing upon DAW software, computer hardware and plug-ins.  

In situations where the throughput latency is higher than desired, the input to 
the MixPre-3 can be directly monitored in the headphone output.

To monitor with zero-latency through the MixPre-3:

1. Connect MixPre-3 to computer.

2. Confirm that the LR Stereo HP Preset is selected.

3. Select USB1 for Channel 1 source and Pan L.

4. Select USB2 for Channel 2 source and Pan R.

5. Connect microphone or other input to Channels 3.

6. Select Mic for Channel 3 source. This input will appear to your computer as 
USB stream 3.

7. Setup your DAW software for a new track with its source being Channel 3 
and be sure that record monitoring is disabled for this track. (Optionally, 
you may mute the channel’s output in the DAW).

8. You should now be able to hear and adjust the output of your DAW audio 
through Channels 1 and 2 while adjusting your low-latency feed in your 
headphones and to the DAW with Channel 3.  Use the channel 3 knob to 
adjust the send level to the DAW.  Use channel 1 and 2 knobs to adjust the 
mix of the DAW audio with channel 3 to taste.

USB File Transfer

The MixPre-3 can support USB file transfer between its SD and a USB-connect-
ed host computer.  In order to use this feature, it’s necessary to put the Mix-
Pre-3 into File Transfer mode. (USB audio will be suspended.) 

To enter File Transfer mode:

1. Tap .

2. Tap System > File Transfer.  

3. When file transfer is complete, tap Exit on the USB-C File Transfer Mode 
screen to return to the previous operating state.
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USB Keyboard

The use of standard USB computer keyboards is supported.  When using the 
MixPre-3 in situations requiring extensive metadata entry, titling and wired re-
mote control capability, a USB keyboard may be desirable.  

 L Keyboards with an embedded USB hub and Apple brand keyboards are not com-
patible. Additionally, some keyboards must be connected only after the recorder is 
turned on.

USB-C Mode

When connected to a computer via USB-C, the MixPre-3 may be setup to be 
powered from the host without the computer identifying it as an audio interface.  

To toggle between the USB-C audio/power modes:

1. Tap .

2. Tap System > USB-C. Options include: Audio and Power Only.
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Timecode

Timecode Modes

The MixPre-3 is not only a fantastic tool for audio enthusiasts. It was also con-
ceived for all you video aficionados out there, whether you are a film or doc-
umentary maker or a YouTuber who wants no-compromise audio quality to go 
along with their video content.

With that in mind, we have designed-in timecode capability to make it easy to 
lip-sync DSLR and other camera video with the MixPre-3’s audio. This is par-
ticularly useful in what is known as ‘double system sound’ applications where 
audio is recorded separately from the video camera. In simple video/audio 
productions, it is often sufficient to simply use the MixPre-3 as a high quality 
mic-preamp/mixer and record the audio on the DSLR into the same file as the 
video content. This is known as single system and in this case, the video and 
audio are already lip-synced. However, there are often times where it is very 
beneficial to record  each audio source as a separate isolated (ISO) track. Ac-
cess to these ISO tracks allows the ability to clean up and remix audio sources 
after the event in post production. To record ISO tracks and sync them with 
video from a DSLR, you need a multichannel recorder with built in timecode 
support like the MixPre-3.

In the audio for video category, no one does timecode better than Sound De-
vices. It’s no surprise that many Oscar winning movies have had their sound 
recorded using Sound Devices gear.

For some reason, timecode gets a bad rep  as being difficult to understand, 
but really it is quite simple. It is basically a time label that runs from 0 to 24 
hours and is counted in hours (HH), minutes (MM), seconds (SS), and frames 
(FF). A timecode value will look like this - HH:MM:SS:FF. Timecode ranges from 
00:00:00:00 to 23:59:59:29, then starts over. 

All you have to do to synchronize separate video and audio content is to ensure 
that the camera and MixPre-3 are both labeling each moment in time with the 
same timecode value. Then in your video editing software, whether it be Final 
Cut, Adobe Premiere, or Avid Media Composer, you simply import your separate 
audio and video content and match up the timecode numbers (computers are 
good at matching up numbers) and “Hey Presto,” you have lip-synced video and 
audio.

The MixPre-3 has three timecode modes, HDMI TC In, Aux In 1 or 2, and Time 
of Day.
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HDMI TC In

Use a DSLR camera that outputs timecode over its HDMI output connection. 
A few examples of cameras that do this are the Sony a7s and Panasonic GH4. 
Connect their HDMI output to the HDMI TC In port on the MixPre-3’s right hand 
panel and set Menu>Timecode>TC Mode to HDMI TC In. Refer to the camera’s 
user guide to determine how to output HDMI timecode from the camera since 
all cameras do it in a slightly different way. 

When the MixPre-3 receives HDMI timecode, it is displayed on the Home screen 
beneath the current filename. Each time you press record, the incoming time-
code value is stored inside the MixPre-3’s WAV file. Most popular video editing 
applications will be able to read this timecode value and sync the audio with the 
camera video.

Aux In 1, Aux In 2

LTC, otherwise known as SMPTE Linear Timecode is the most common timecode 
standard. Many professional cameras and other devices output this format.  
This can be received by the MixPre-3 via its Aux/Mic In 3.5mm connector.  

To enable Aux In Timecode:

1. Set the Aux In Mode to Timecode (Menu>Inputs>Aux In Mode) - this is only 
available in Advanced mode.

2. Set Menu> Timecode>TC Mode> to Aux In 1 or Aux In 2. 

When the MixPre-3 receives Aux In timecode, it is displayed on the home 
screen beneath the current filename.

Time of Day (TOD)

Use TOD mode, when you want the recorded WAV files to be timecode stamped 
with the time of day. The time of day is derived from the MixPre-3’s built-in 
date/time clock. This mode is not used for frame accurate synchronization with 
external devices. Rather, it is used as simple way of logging what time a record-
ing took place. 

Timecode Frame Rate Auto-Detection

With both the HDMI TC In and Aux In Timecode modes, the MixPre-3 auto-de-
tects the incoming timecode frame rate and stamps the recorded files accord-
ingly.
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Timecode Stamp

Regardless of which timecode mode you use, each time you press record, the 
timecode value at that moment is embedded within the MixPre-3’s WAV file. 
Most popular video editing applications will be able to read this timecode value 
and sync the audio with the camera video.

For those of you who are curious, WAV files that contain embedded timecode 
are called Broadcast WAV files. They are identical to standard WAV files but 
contain extra non-audio metadata such as timecode and other descriptive data 
about the recording.
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Files, Projects

Each time you press record, the MixPre-3 creates a WAV audio file which can 
subsequently be played back on the MixPre or almost any computer audio 
application. The MixPre-3 is able to record up to 5 tracks (the stereo mix LR 
tracks plus three isolated tracks) into a single polyphonic WAV file.  Polyphonic 
simply refers to the fact that the file contains multiple tracks.

File Name Format

The MixPre-3 makes it easy to identify and organize your recordings (WAV files) 
by providing the ability to name them before, during, or after recording.

Each recording’s file name is comprised of a Name (maximum 9 characters), 
followed by a dash (-), and then followed by a Number (3 digits). For example:

MIXPRE-001.WAV

Name = MIXPRE

Number = 001

Each time you press record, the Number is incremented. 

The Number is reset to 1 whenever you create a new Name.

Naming a Recording

To name a recording:

1. Go to the File List by tapping the top left region of the Home screen.

2. Select a file from the list by using the headphone encoder on the right pan-
el. Rotate to highlight a file then press the encoder (or touch Edit) to select 
it for naming or press the Play button to play it. 

 L The File List is in chronological order with most recent recordings at the top of the 
list. The row at the very top of the list represents the next file to be recorded. Se-
lecting this allows you to give a name to the next recording prior to recording it.

3. Select Name to edit the Name. 

4. Select Number to edit the Number.

The Name and Number not only determine the filename of the recording—
they are also embedded inside the WAV file. This is particularly useful in 
film and TV production where the data is used to help log and locate con-
tent faster.

In Advanced mode you can also rename a recording. 
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To rename a recorded file:

 X In the File List, select a file by pressing the encoder, and tap Rename.

Track Names and Notes

In Advanced mode, you also have the option to store track names and notes 
inside the WAV file. This is ideal for multitrack recording where you want to 
identify what or who is recorded on a particular track and for adding descriptive 
notes about the recording that might be useful to an editor at a later stage.

To edit track names and notes:

1. In the File List, select a file and press the encoder

2. Do any of the following: 
 X Select Track Names to change track names.
 X Select Name, Num Notes to edit notes.

Undo, Trash File

In Advanced mode, you can undo the last file recorded. Undo moves the last re-
corded file to the SD card’s UNDO folder. Files in this folder are accessible using 
a computer.

To undo your last recording:

 X In the File List, select a file, press the encoder, and tap Undo.

To trash any file in the File List:

1. In the File List, highlight a file, and tap Edit.

2. Select Trash Take.

Trash File moves the file to the SD card’s TRASH folder. Files in this folder are 
accessible using a computer. You can permanently delete files in the SD card’s 
TRASH folder from the MixPre’s SD Card menu.

Projects

It is easy to end up with many hundreds of WAV files on a single SD card, es-
pecially as cards can hold many gigabytes of audio data. To help organize this 
large number of files, they may be stored in separate folders which, in the Mix-
Pre-3, are known as Projects.  For instance, you may want to organize your 
recordings based on their type, such as PODCASTS, SONGS, INTERVIEWS, 
SOUND FX, NATURE RECORDINGS, etc. Each of these projects would be repre-
sented by a folder located at the root of the SD card.
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To create a new Project:

1. Tap .

2. Tap Project > New and choose to create a custom project name or project 
name based on the current date.

To access files or record new files in a previously created project:

1. Tap .

2. Tap Project > Open.

3. Select the required project. This will load the File List with the selected Proj-
ect’s files. 

To trash a Project:

1. Tap .

2. Tap Project > Trash.

3. Select which project to trash. This moves the selected project and all its 
files to the TRASH folder. Projects in this folder are accessible using a com-
puter. 

 L You can permanently delete projects in the SD card’s TRASH folder from the Mix-
Pre’s SD Card sub-menu.
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Remote Control

Wingman Application

Sound Devices Wingman is a free app that allows wireless remote control of the 
Bluetooth Smart-enabled MixPre Series from iOS devices. 

To enable Bluetooth on the MixPre recorder:

1. Tap . 

2. Tap System > Bluetooth. This toggles Bluetooth On and Off.

 L If a remote password is configured on the recorder itself, Wingman will prompt for 
that password to be entered prior to making the connection.

Status Bar

Viewing Area

Tab Bar

Connection Icon

Wingman’s touch-screen user interface offers easy navigation and monitoring 



User Guide

42

with three main areas of interest:
• Status - Shows device-specific status information.
• Viewing area - Displays different screen views, such as the Transport view 

with its transport control buttons, metadata fields, and meters.  
Swiping vertically in this area can toggle to other meters.  
Swiping horizontally, toggles between Transport and Track views, handy 
when using Wingman app on devices with smaller screens.

Transport View
Track View

• Tab bar - Remaining on screen all the time, the bar has four icons enabling 
access to other views, such as the File list.

 L Not all buttons or tabs are enabled or used for MixPre functionality.

Connecting to a MixPre Recorder

If multiple Wingman-enabled devices are on set, Wingman will display all avail-
able devices within range. You may tap the Connection icon to efficiently switch 
connection from one device to another from within the app. 

 L For productions with multiple recorders of the same model, tapping the Circled-I 
icon helps identify the correct device, by displaying an “Identifying from Wingman” 
message on the chosen recorder’s screen. 
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When running Wingman, the Connection icon, which bears the Sound Devices 
logo, displays different colors. The color of the icon is significant:

color Icon StatuS

Gray Disconnected - either no activity or scanning for devices

Orange Bluetooth connection in progress

Yellow Connected - authentication underway

Green Connected and authenticated

Music Projects via Wingman

Beginning with version 3.20, the Wingman app includes support of Bluetooth 
connection to all M-models of the MixPre Series as well as support of Music 
projects in Classic models with the Musician Plugin activated.  
 
When connecting to a MixPre, Wingman’s user interface changes based on the 
model to which it connects and the type of project opened on the MixPre. 

For instance, in Music projects, the Transport view displays a single meter view 
with all 12 tracks. Likewise, since there is no File list for Music projects, the 
File List icon is removed from the Tab bar. In addition to Record and Stop, the 
Transport control buttons include a Play button for playback, as opposed to the 
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False Take (or “Undo”) button provided on Classic models in Audio projects.   

 L Regardless of model or project, custom naming and arming of tracks may be done 
in Transport view (shown above) on large screen mobile devices, like tablets, or in 
Track view on smaller screen mobile devices, like smartphones.

To rename tracks:

1. Do either of the following: 
 X On large mobile devices, from the Transport view, tap anywhere in a 

vertical meter for the track you want to edit.
 X On small mobile devices, swipe horizontally to display the Track view, 

then tap anywhere in a horizontal meter for the track you want to edit. 

2. Use the virtual on-screen keyboard to modify the track name.

3. Tap Done when finished to save the changes.

 L Tap anywhere on screen other than the keyboard to exit without saving changes.

To arm/disarm tracks:

 X Tap the meter label. When armed the label turns red. When on but dis-
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armed, the label is gray. When the input is off, the label is black and cannot 
be armed. And in Music projects, when playing back or overdubbing, labels 
for on but disarmed tracks appear green. 

 L Meter labels are joined (displayed as a single label) to indicate when channels are 
linked. This is shown in the previous example; see the meter labels for 9 and 10.

HDMI Record Trigger

The MixPre-3 may be configured to begin recording when it is triggered to do so 
from an HDMI record flag from compatible DSLR cameras with HDMI output. By 
default, record triggering is turned off.  Setting the Record Trigger to HDMI flag 
will initiate record when a compatible device issues the record flag via the HDMI 
input.    

To access the Record Trigger settings:

1. Tap .

2. Tap Record > Rec Trigger.

Linear Timecode (LTC) Record Trigger

The MixPre-3 may be configured to begin recording when it detects running LTC 
timecode via the Aux input when set to Timecode. Set Rec Trigger to Timecode 
to activate this feature.
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Keyboard

A connected USB keyboard may be used as a wired remote control for cer-
tain functions of the MixPre-3. See the table below for available USB keyboard 
shortcuts.

USB Keyboard Shortcuts

When a USB keyboard is attached, the following key-combinations or shortcuts 
are available. 

KeyStroKeS actIon

Escape Back. Also cancels out of editing mode when virtual keyboard is on 
screen

F1 or Menu key Accesses the Main menu
F12 Home
F2 File list
F3 Cycles between available Meters views and the Main screen
Ctrl + R Record
Ctrl + S Stop
Spacebar Play
Left Arrow Main screen: Rewind

Menu and Input Settings screens: Toggles through pages
Right Arrow Main screen: Fast forward

Menu and Input Settings screens: Toggles through pages
Up / Down Arrows Main screen: Adjusts headphone volume

In menus: Duplicates encoder rotation, such as moves highlight, 
scrolls list

While editing parameters: Changes the value
Enter In menus: Activates current selection. (Same as encoder press.) Also, 

same as choosing OK when virtual keyboard is on screen
Q In menus: select top left option in quad button view
W In menus: select top right option in quad button view
A In menus: select bottom left option in quad button view
S In menus: select bottom right option in quad button view
1-3 Channel Settings screen for 1-3
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USB Controllers

Beginning with firmware v3.00 and higher, the MixPre Series (including M mod-
els) can be connected to selected third party controllers for tactile control of 
mixing and recording. 

No matter whether you are creating music, podcasts or recording sound for pic-
ture, these control surfaces provide yet another cool way to interact with your 
MixPre in addition to operating MixPre direct from its front panel or from the 
Bluetooth Wingman App for iOS and Android.

The MixPre-Series can be controlled by the following USB controllers: 
• Korg NanoKontrol Studio 
• Korg NanoKontrol 2
• Novation LaunchControl XL
• Akai MidiMix

These control surfaces provide a varied range of physical sliders, pots, and 
buttons to set fader levels, trim gains, pans, reverb sends, solos, mutes, record 
arming, transport control and more. Functionality varies depending on control-
ler model and whether you are working in Music or Audio projects. 

 L Not all functions are supported by all controllers.

Connecting the MixPre to a Controller

Power and control is provided via a single USB cable to better facilitate simple 
connection between the MixPre and controller. To ensure compatibility with the 
connected controller, the MixPre must first configure itself accordingly. 

 L For the MixPre-3 and -6, USB Controllers will only function if the MixPre is ade-
quately powered.

To connect a controller: 

1. Connect one end of a USB cable to the MixPre’s USB-A port and the other 
end to the controller’s USB port which can be a USB-B, Micro USB, or Mini 
USB port depending on the controller model.  
 
We recommend using the USB cable supplied with the controller.

 L It is okay to connect the MixPre to the controller while powered up. 

2. The MixPre automatically starts setting itself up to work with the attached 
controller. During this short time, a popup displays the controller model. 
After a few seconds, the popup closes and the controller is ready to use.

 L When connected to the MixPre, some functions are taken over by the control-
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ler and are therefore disabled on the MixPre. Depending on the controller model, 
these functions may include faders, trims, pans, reverb sends, and low cut filters.

Map User-Definable Buttons to Shortcuts

You can customize designated buttons/knobs on a controller to operate certain 
functions on the MixPre. Functions that may be assigned include:
• Tone
• L/R Mute
• X1/X2 Mute
• Undo (Audio project only)
• Slate Mic (Audio project only)
• Metronome (Music project only)
• Add Q
• Record
• Stop
• Play
• Rewind
• Fast Fwd
• Shuttle (not all controllers)

To map controller buttons to perform MixPre functions:

1. Connect a controller.

2. On the MixPre, access Menu > * Shortcuts > Control Surface

3. Set any of the user-definable shortcut buttons to your required function.

Controller Interfaces

Each third-party controller has different capabilities. The following tables  
Akai MidiMix Interface | Korg NanoKontrol 2 Interface |  
Korg NanoKontrol Studio Interface | Novation LaunchControl XL Interface 
describe the functionality of each controller in Music and Audio projects:

 L The MixPre M-Series models do not support Audio projects.
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Akai MidiMix Interface

FunctIon muSIc ProjectS auDIo ProjectS

Fader Bank Switching Bank Left = Select fader bank to 
the left

Bank Right = Select fader bank to 
the right

--

User-Definable Shortcut But-
tons

Solo + Bank Left

Solo + Bank Right

Solo + Bank Left

Solo + Bank Right
Record via user-definable shortcut via user-definable shortcut
PLAY via user-definable shortcut via user-definable shortcut
STOP via user-definable shortcut via user-definable shortcut
FFWD X2, X16 via user-definable shortcut via user-definable shortcut
RWD X2, X16 via user-definable shortcut via user-definable shortcut
Skip Next File -- via user-definable shortcut  

(Tap Fast Forward)
Skip Prev File -- via user-definable shortcut  

(Tap Rewind)
Skip Next Mark via user-definable shortcut  

(Fast Forward)
via user-definable shortcut  
(Fast Forward)

Skip Prev Mark via user-definable shortcut  
(Rewind)

via user-definable shortcut  
(Rewind)

Return to Zero via user-definable shortcut  
(Stop twice)

via user-definable shortcut  
(Stop)

Shuttle Only via MixPre Only via MixPre
Record Arm REC Arm button REC Arm button
Record Arm Status Red REC Arm button when armed Red REC Arm button when armed
Input Monitor Solo + REC Arm buttons --
Input Monitor Status Red REC Arm button when Solo is 

pressed
--
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FunctIon muSIc ProjectS auDIo ProjectS

Channel Screen Access Press Bank Left/Right and REC Arm 
to access channel screen

Solo + REC Arm buttons

Faders Linear faders 1-8 Linear faders 1-8
Trims Top row knobs Top row knobs
Pans Bottom row knobs Bottom row knobs
Reverb Middle row knobs --
Low Cut Only via MixPre Middle row knobs
Mute Mute button Mute button
Solo Solo + Mute buttons Solo + Mute buttons
Mute Status Yellow Mute button Yellow Mute button
Solo Status Yellow Mute button when Solo is 

pressed
Yellow Mute button when Solo is 
pressed

L/R (Stereo) Output Gain Master fader Master fader
L/R (Stereo) Output Mute via user-definable shortcut via user-definable shortcut
X1/X2 Mute (10M/10T only) via user-definable shortcut via user-definable shortcut
Tone via user-definable shortcut via user-definable shortcut
Metronome via user-definable shortcut --
Create Q via user-definable shortcut via user-definable shortcut
Undo Only via History List on MixPre via user-definable shortcut
Internal Mic (10M/10T only) Only via Input patchbay via user-definable shortcut
SEND ALL Button Sends all current fader, knob set-

tings to MixPre
Sends all current fader, knob set-
tings to MixPre

Korg NanoKontrol 2 Interface

FunctIon muSIc ProjectS auDIo ProjectS

Fader Bank Switching Track < button = Select fader bank 
to the left

Track > button = Select fader bank 
to the right

--

User-Definable Shortcut But-
tons

Cycle + Marker Set

Cycle + Marker <

Cycle + Marker >

Cycle + <<

Cycle + >>

Cycle + Marker Set

Cycle + Marker <

Cycle + Marker >

Cycle + <<

Cycle + >>
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FunctIon muSIc ProjectS auDIo ProjectS

Record Record button Record button
PLAY/Pause Play button Play button
STOP Stop button Stop button
FFWD X2, X16 Hold >> button Hold >> button
RWD X2, X16 Hold << button Hold << button
Skip Next File -- Tap >> button
Skip Prev File -- Tap << button
Skip Next Mark Tap >> button Tap >> button
Skip Prev Mark Tap << button Tap << button
Return to Zero Tap Stop when stopped Tap Stop
Shuttle Only via MixPre Only via MixPre
Record Arm R button R button
Record Arm Status Red R button when armed Red R button when armed
Input Monitor Cycle + M button --
Input Monitor Status Red M button when Cycle pressed --
Channel Screen Access Cycle + S button Cycle + S button
Faders Linear faders 1-8 Linear faders 1-8
Trims Rotary knobs (set to trim) Rotary knobs (set to trim)
Pans Rotary knobs (set to pan) Rotary knobs (set to pan)
Reverb Rotary knobs (set to reverb) --
Low Cut Only via MixPre Rotary knobs (set to low-cut)
Mute M button M button
Solo S button S button
Mute Status Red M button Red M button
Solo Status Red S button Red S button
L/R (Stereo) Output Gain Only via MixPre Only via MixPre
L/R (Stereo) Output Mute via user-definable shortcut via user-definable shortcut
X1/X2 Mute (10M/10T only) via user-definable shortcut via user-definable shortcut
Tone via user-definable shortcut via user-definable shortcut
Metronome via user-definable shortcut --
Create Q Marker Set button Marker Set button
Undo Only via History List on MixPre via user-definable shortcut
Internal Mic (10M/10T only) Only via Input patchbay via user-definable shortcut
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Korg NanoKontrol Studio Interface

FunctIon muSIc ProjectS auDIo ProjectS

Fader Bank Switching Track < button = Select fader bank 
to the left

Track > button = Select fader bank 
to the right

--

User-Definable Shortcut But-
tons

Cycle + Marker Set

Cycle + Marker <

Cycle + Marker >

Cycle + <<

Cycle + >>

Cycle + Marker Set

Cycle + Marker <

Cycle + Marker >

Cycle + <<

Cycle + >>
Record Record button Record button
PLAY Play button Play button
STOP Stop button Stop button
FFWD X2, X16 Hold >> button Hold >> button
RWD X2, X16 Hold << button Hold << button
Skip Next File -- Tap >> or Marker >button
Skip Prev File -- Tap << or Marker < button
Skip Next Mark Tap >> or Marker > button Tap >> or Marker > button
Skip Prev Mark Tap << or Marker < button Tap << or Marker < button
Return to Zero Tap |< or Stop when stopped Tap |< or Stop
Shuttle Press MixPre HP encoder or set 

Shuttle as a shortcut, then use se-
lected shortcut and scrub wheel.

Press MixPre HP encoder or set 
Shuttle as a shortcut, then use se-
lected shortcut and scrub wheel.

Record Arm REC Arm button REC Arm button
Record Arm Status White REC Arm button when armed White REC Arm button when armed
Input Monitor Select button --
Input Monitor Status White Select button --
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FunctIon muSIc ProjectS auDIo ProjectS

Channel Screen Access Press Cycle so that it’s illuminated, 
then press a Select button

Select button

Faders Linear faders 1-8 Linear faders 1-8
Trims Scene 1 then use knobs Scene 1 then use knobs
Pans Scene 3 then use knobs Scene 3 then use knobs
Reverb Scene 2 then use knobs --
Low Cut Only via MixPre Scene 2 then use knobs
Mute Mute button Mute button
Solo Solo button Solo button
Mute Status White Mute button White Mute button
Solo Status White Solo button White Solo button
L/R (Stereo) Output Gain Only via MixPre Only via MixPre
L/R (Stereo) Output Mute via user-definable shortcut via user-definable shortcut
X1/X2 Mute (10M/10T only) via user-definable shortcut via user-definable shortcut
Tone via user-definable shortcut via user-definable shortcut
Metronome via user-definable shortcut --
Create Q Marker Set button Marker Set button
Undo Only via History List on MixPre via user-definable shortcut
Internal Mic (10M/10T only) Only via Input patchbay via user-definable shortcut

Novation LaunchControl XL Interface

FunctIon muSIc ProjectS auDIo ProjectS

Fader Bank Switching Track Select < button = Select fad-
er bank to the left

Track Select > button = Select fad-
er bank to the right

--
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FunctIon muSIc ProjectS auDIo ProjectS

User-Definable Shortcut But-
tons

UP 

DOWN 

Device + UP

Device + Down

Device + Left

Device + Right

UP 

DOWN 

Device + UP

Device + Down

Device + Left

Device + Right
Record via user-definable shortcut via user-definable shortcut
PLAY via user-definable shortcut via user-definable shortcut
STOP via user-definable shortcut via user-definable shortcut
FFWD X2, X16 via user-definable shortcut via user-definable shortcut
RWD X2, X16 via user-definable shortcut via user-definable shortcut
Skip Next File -- via user-definable shortcut
Skip Prev File -- via user-definable shortcut
Skip Next Mark via user-definable shortcut via user-definable shortcut
Skip Prev Mark via user-definable shortcut via user-definable shortcut
Return to Zero via user-definable shortcut  

(Stop twice)
via user-definable shortcut (Stop)

Shuttle Only via MixPre Only via MixPre
Record Arm Select Record Arm, then Track Con-

trol button
Select Record Arm, then Track Con-
trol button

Record Arm Status Red Track Control button when Re-
cord Arm is selected

Red Track Control button when Re-
cord Arm is selected

Input Monitor Track Focus buttons --
Input Monitor Status Illuminated Track Focus button 

Monitor is On
--

Channel Screen Access Hold Device button, then Track 
Focus button

Track Focus buttons

Faders Linear Faders 1-8 Linear Faders 1-8
Trims Top row of knobs Top row of knobs
Pans Bottom row of knobs Bottom row of knobs
Reverb Middle row of knobs --
Low Cut Only via MixPre Middle row of knobs
Mute Select Mute, then Track Control 

button
Select Mute, then Track Control 
button

Solo Select Solo, then Track Control 
button

Select Solo, then Track Control 
button

Mute Status Red Track Control button when 
Mute is selected

Red Track Control button when 
Mute is selected

Solo Status Flashing Track Control button when 
Solo is selected

Flashing Track Control button when 
Solo is selected

L/R (Stereo) Output Gain Only via MixPre Only via MixPre
L/R (Stereo) Output Mute via user-definable shortcut via user-definable shortcut
X1/X2 Mute (10M/10T only) via user-definable shortcut via user-definable shortcut
Tone via user-definable shortcut via user-definable shortcut
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FunctIon muSIc ProjectS auDIo ProjectS

Metronome via user-definable shortcut --
Create Q via user-definable shortcut via user-definable shortcut
Undo Only via History List on MixPre via user-definable shortcut
Internal Mic (10M/10T only) via Input patchbay only via user-definable shortcut
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Musician Plugin

The Musician plugin brings the essence of computer-based music production 
software to the super-compact MixPre-3, -6 and -10T recorders. 

Musicians and songwriters now have an easy to use, portable tool for creating 
high quality, multi-layered songs anywhere and anytime that inspiration grabs 
them. 

It includes the following features:
• Track Laying
• Overdubbing
• Punch In/Out
• Track Bouncing
• Reverb and Vocal Air Effects
• Metronome
• Input to Track Routing
• Rendering  
• Importing

The plugin works in a similar fashion to any DAW such as Protools, Logic, Cu-
base, Reaper etc.; however, it is intentionally simplified to allow musicians to 
focus on their art rather than getting bogged down in all the technical stuff. 

The Musician plugin allows you to simultaneously record, playback, mix, mon-
itor, layer, and overdub up to 12 tracks and if you need more, use the Bounce 
feature to free up more tracks. After your song is complete, you can mix and 
render (export) it for sharing with others.

With the plugin activated, there are two types of projects: the original Audio 
project and a new Music project. In a Music project, you can start recording, 
layering and overdubbing tracks, just like a DAW.  

With the plugin, and in Music projects, the MixPre-3 lets you record three in-
puts simultaneously, the MixPre-6 allows you to record six inputs at once, and 
the 10T permits up to eight. 

 L Music projects are limited to 96kHz. On MixPre-6 and MixPre-10T recorders, Audio 
projects do not have this limit, so the maximum sample rate for Audio projects 
remains 192kHz.

The built-in metronome helps you to keep your performance in time while the 
reverb and vocal air effects add character to your recording and can aid in in-
spiring a great performance. The vocal air effect is an easily dialled-in combina-
tion of EQ and compression that results in an airy sheen and intimacy to vocals, 
popular today with singer/songwriters.
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Installing and Activating the Plugin

The Musician plugin may be purchased from the Sound Devices online store at: 
https://store.sounddevices.com/product/musicians-plugin/. 

To install and activate the plugin: 

1. Purchase and download the license—an .LIC file—to an SD card.

 L The Musician plugin is licensed to a MixPre recorder and its serial number, so it 
cannot be transferred to another device or to multiple MixPre devices. 

2. Insert the SD card into the MixPre and turn on the recorder. 

1. Tap .

2. Tap System > Plugins.

3. Tap Apply Plugins. This installs the license, activates the plugin, and reboots 
the device. 

Music Projects

Each Music project’s folder on the SD card stores all your song’s audio files and 
settings. This makes it easy to organize, share, and copy your musical cre-
ations. The project folder also includes a special ‘session’ file that enables the 
MixPre to control precisely where on the timeline and on which track the proj-
ect’s recorded audio files should be played back. 
Conceptually, a Music project operates like a typical DAW and as such you can 
visualize it in much the same way. A play cursor moves across a horizontal 
timeline and audio tracks (referred to as ‘channels’ in the MixPre) are laid out 
as rows. A song always starts at 00:00:00:0 (hh:mm:ss:tenths), bar 1.
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You can store many projects on an SD card, which is great if you are working on 
multiple songs or an album, because you can quickly switch between them. 

Only one project is active at any one time.

Music Project Folder Structure

A Music project folder contains the following files:

• The project’s recorded audio WAV files. Each track is represented by a sin-
gle monophonic WAV file. 

 L The file name is derived from the date and time the recording was finished. 
For example, a recording finished at 1:33 PM (13:33) on the 23rd of March 
2018 would have a name like this: 001-032318-133300

See Music Project History for more about the recorded files.

• A render folder containing all rendered audio files and a SESSION.XML file 
which manages how audio files are played back as well as storing settings 
for the project. 

You can view the contents of a Project folder on a computer. 

Creating a New Music Project

To create a new Music project:

1. Tap .

2. Tap Project > New > Music.

3. Enter a name and tap OK. By default the name is Song followed by a nu-
merical value, such as Song1.

4. Tap Create. The new Music project is created with its name shown at the 
top of the Home screen.

 L When switching between Music and Audio projects, either when creating a new 
project or opening an existing one, the MixPre reconfigures to optimize perfor-
mance for each project type. This reconfiguration requires that the unit restarts 
which can take a few seconds.
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Import Recording

When creating a new Music project, you may choose to import a .wav audio file 
(up to 12 tracks) as the foundation for your project. This is ideal for importing 
multitrack audio from a DAW should you want to continue developing your com-
position in the MixPre. Or perhaps you’ve created a backing track in your DAW 
for a live performance and want to use the MixPre as your all-in-one playback 
device and mixer during the show. 

 L You may also import .wav files from Audio projects recorded using the MixPre-3M, 
MixPre-6M, or MixPre-10M models. File names must be kept to less than 40 char-
acters; longer names are not supported.

To create a project based on a non-native poly WAV file:

1. Tap .
2. Tap Project > New > Music > Import Recording. 
3. Select your file from the those available on the SD card:

 X Use the HP encoder to select a .wav file from the root of the SD card.
 X Scroll to and select the an Audio project folder first, then choose a .wav 

file to import it from within the folder. 

Opening an Existing Music Project

Open an existing song to continue working on it.

To open a Music project:

1. Tap .

2. Tap Project > Open. A list of all projects on the SD card are displayed. Music 
projects are identified by the Music Notes icon. 

3. Scroll through the list and press the HP encoder to select the one you want.

Once selected, the project is opened and the Home screen is displayed. You are 
ready to start recording. 

 L When switching from the current project to another project, you do not need to 
worry about saving the current one - the MixPre auto-saves the current project’s 
state. If switching between Music and Audio projects, the MixPre will reconfigure to 
optimize performance for each project type. This reconfiguration requires that the 
unit restarts which can take a few seconds.
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Home Screen for Music Projects

When a Music project is active, the Home screen looks different than it does for 
Audio projects. It appears something like this:

Status Bar

Q Icon & Cue NumberMusic Icon

Time Counter

Punch IndicatorRemaining Time

SD Card Icon

Track Bank Selector
Meter View

Limiter Indicator

Track Labels

L/R Mix Meters

Power Status Icon

Menu Icon

 L The sample image shows the Home screen on a MixPre-3, as indicated by the 
Track Bank Selector (white box) being around only three meters. This appears dif-
ferently on the MixPre-6 and MixPre-10T.

Here are the more obvious differences you will find on the Home screen when a 
Music or Audio project is active—items such as:

 

Project name Icon DeScrIPtIon

Music Music Notes icon Indicates that the current project is a Music project.  
Tap this icon to access the Music Control menu.

Audio Audio File icon Indicates that the current project is an Audio project.  
Tap this icon to access the File List.

Both Current file name Displays current name of active Music project or audio file. 
Both Time counter For Music projects, the time counter indicates the cur-

rent Song Position in hh:mm:ss:tenths. All songs start at 
00:00:00:0.

For Audio projects, the time counter displays timecode.
Both Q icon Displays numerical cue markers. When playing or record-

ing, tapping this icon sets a cue mark at current location. 
When stopped, tapping this icon provides access to the Cue 
Points menu.

For more information, see Working with Cue Points.



61

Rev#

Project name Icon DeScrIPtIon

Music Meter Views When a Music project is active, only one meter view is 
available. It displays the metering for the 12 tracks and 
stereo mix, LR. 

Tap meters to switch track banks. For more information, 
see Track Bank Selector.

Audio When an Audio project is active, three different meter 
views are available, and you can cycle through the views 
by tapping the meters.

Music Status bar Cycle status information by touching:
• Song status: current bar position as well as Punch and 

Metronome, rendering status, and remaining time: In 
idle or record, the remaining time field displays re-
maining time on the SD card. In play, the field displays 
remaining time to the end of the song.

• USB drive status: remaining space on drive, if present, 
and when it is actively copying (Applies to 10T only)

• Date & Time
Audio Cycle status information by touching:

• SD card status: card/drive activity, available recording 
time, file duration, elapsed time, and headphone preset

• USB drive status: remaining space on drive, if present, 
and when it is actively copying (Applies to 10T only)

• Sample rate and bit depth
• Date and time

Music Control Menu

The Music Control menu provides access to the project’s History list, Cue list, 
the Render and Metronome features, and the Solo/Mute screen.

To access the Music Control menu:

 X Tap .

Music Project History

Each recording is logged as an item (revision) in the History list. This makes it 
easy to “undo” to an earlier recording or “redo” to a later recording—ideal for 
quickly redoing a bad take or comparing different takes. The History list is in 
chronological order with the most recent recording at the top.

To access the History list and switch to an earlier or later recording:

1. Tap  to open the Music Control menu.

2. Tap History. The History list appears. 
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3. Use the HP encoder to select a file in the list. The current recording is indi-
cated by an asterisk (*) after its revision’s file name. 

 L The revision’s file name is derived from the date and time the recording was fin-
ished. For example, a recording finished at 2:22 PM (14:22) on the 12th of March 
2018 would have a name like this: 001-031218-142200

To restart the current project from scratch:

 X From the History list, scroll to the bottom, and select Restart Song. 

 ⚠ This will clear all audio from the project and cannot be undone. Howev-
er, the audio files themselves are not actually deleted; they remain in the 
project folder, which can be accessed using a computer.

Track Bank Selector

Since there are more possible tracks (twelve) in Music projects than physical 
Channel knobs (three on MixPre-3, four on MixPre-6, and eight on MixPre-10T), 
a Track Bank Selector is used to select which group of tracks you want to con-
trol with the knobs on the front panel.

The Track Bank Selector appears as a white box (or boxes) around the selected 
tracks. The following images show examples of different selected tracks, on 
MixPre-10M (left), MixPre-6M (center), and MixPre-3M (right):

  

To switch track banks on a MixPre-3:

 X Tap meters to cycle through each trio of tracks: 1-3, 4-6, 7-9, and 10-12.
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To switch track banks on a MixPre-6:

 X Tap meters to cycle through each quartet of tracks: 1-4, 5-8, and 9-12.

On the MixPre-10T, the top row of four Channel knobs always control tracks 1-4.

To switch track banks on a MixPre-10T:

 X Tap meters to toggle control of bottom four knobs from tracks 5-8 to 9-12.

When a track bank is switched, rotating a Channel knob in the newly selected 
bank will not have an effect on level until it reaches its previously stored fader 
value. As soon as it reaches that value, the gain will adjust normally in relation 
to the knob’s rotational position. 

 L Upon switching track banks, if the knob’s rotational position is not aligned with its 
fader value, the LEDs for that knob will illuminate with a pulsing orange light. This 
will stop once position and value are re-aligned.

When adjusting the Channel knob, its fader value along with the previously 
stored value is shown in orange text at the top of the Home screen and Channel 
screens until it reaches its previously stored value, at which point it changes to 
black text. 

For example:

In this example, the Channel knob for track 9 must be rotated clockwise, as in-
dicated by the arrow, from its current fader value of -18dB. After it reaches the 
track’s previously stored value of -15dB, the mix level will start to be affected.

 L Adjust the Channel knob a small fraction to display the stored value and arrow in 
orange text. The displayed arrow and stored value will inform you which way to 
rotate the knob.
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Channel Screens for Music Projects

To access the Channel screen:
 X Push in a Channel knob. 

 

Each Channel screen provides two pages of settings—indicated by Dots icon. Tap 
the Dots icon to switch pages.

SettIngS DeScrIPtIon or lInK For more InFormatIon

Solo & Mute Using Solo/Mute
Arm Tap to arm a track.
Input Setting Input Source

Monitor Enabling Monitoring
Gain Tap to set the trim gain (pre-fader gain) for the channel. This 

gain determines the signal level on the channel’s individual 
(ISO) track.

Pan Tap to set the position of the track in the LR stereo mix. The 
range has 33 positions from L16 (fully left) to C (Center) to 
R16 (fully right).

Reverb & (Vocal) Air Using Reverb & Rendering a Vocal Air Effect
Low Cut Use Low Cut to attenuate undesirable low frequencies such 

as mic handling noise and wind noise.
Phase Toggling Phase Inversion
Linking Stereo Track Linking

Setting Input Source

The MixPre-3 accepts XLR mic/line, 3.5mm (Aux In), and USB sources. The Mix-
Pre-6 and MixPre-10T accept XLR/¼-inch combo mic/line, 3.5mm (Aux In), and 
USB sources. You can route any of these physical inputs to any track via the 
Channel screen. 

Because any input can be routed to any track, this reduces the need to re-plug 
inputs when you want to record an input to a different track. You can also select 
as a source the MixPre’s mixer outputs (see Bouncing), a metronome click (see 
Metronome) or turn on Phantom power.
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To route input sources for tracks:

1. Enter the Channel screen, tap Input.  
 
The Routing screen appears similar to those shown in these examples from 
MixPre-10M (left), MixPre-6M (center), and MixPre-3M (right).

   

2. Select an input for the track. A track can only have one live input source.

3. Select Phantom if you want to turn on Phantom power for a Mic source. 
Phantom toggles 48V Phantom on and off. Turn Phantom on if a condenser 
microphone is being used.

 L Notice in the previous screenshots how Phantom is only an option when a Mic 
source is selected.

4. Select Click as an input for your track if you want to record the metronome 
click into your song. This is useful should you want to later import the song 
into a DAW to develop the song further. The recorded metronome will allow 
you to set the DAW’s tempo and internal metronome so that it is perfectly 
aligned with the MixPre recording. For more information, see Metronome.

 L TIP: (10T only) If you don’t have a mic handy and want to quickly record a rough 
scratch track of a song idea and are not too concerned about the audio quality, 
you can use the built-in slate mic. To select this as an input, first set  Inputs>Aux 
In Mode to Slate Mic, and then from the (Channel > Input) Routing screen, select 
Slate Mic. Note that Slate Mic will only appear as an Aux In option on the Routing 
screen when Aux In Mode is set to Slate Mic.

Enabling Monitoring

The Monitoring feature lets you hear the live input signal during playback. This 
is particularly useful when practicing along with already recorded tracks or per-
forming live to a backing track.

To enable monitoring:

 X Enter the Channel screen, tap Monitor. The button appears orange when on, 
except if input is off.
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Using Solo/Mute

In Music projects, the MixPre offers a few different ways to mute or solo tracks. 
• From each track’s Channel screen, tap Mute to mute the selected track. This 

removes the signal from recorded tracks, mix and all outputs. When muted, 
its LED ring will glow red. Multiple tracks may be muted at the same time.

• From each track’s Channel screen, tap Solo to hear only the selected track 
(pre-fade/pre-effects) in both ears of the headphone output. When a track 
is soloed, its LED ring will flash orange. 
Like Mute, soloing is non-exclusive, meaning any number of inputs may be 
soloed at the same time. 

You can quickly solo/mute several tracks from the Solo/Mute screen. All 12 
tracks’ Solos and Mutes may be viewed and set from this screen. 

To solo or mute tracks from the Solo/Mute screen:

1. Tap . The Music Control screen appears.

2. Tap Solo/Mute. The Solo/Mute screen appears.

3. Do either of the following: 
 X Tap either Solo or Mute and then tap track(s) to select them. Soloed 

channels appear orange; muted tracks appear red.
 X Use the HP encoder to highlight (green outline) a track and then tap 

either Solo or Mute.

4. Tap  to exit the screen.
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Using Reverb

Reverb sets how much reverb is added to a track in the LR mix. Only the mix is 
affected, not the individual recorded tracks. 

 L To render the reverb effect into the individual recorded tracks, you must use the 
Bounce feature.

To adjust reverb:

 X From the Channel screen, tap Reverb and turn encoder. Range is Off, -50dB 
to 0 dB in 1 dB increments.

You can also select different reverb characteristics—such as type, decay, prede-
lay, etc. Max sampling rate for reverb is 48 kHz.

To configure Reverb:

1. Tap .

2. Page through submenu and tap Reverb.

3. Tap any of the following settings and adjust values accordingly:

SettIng oPtIonS

Reverb Type Off, Plate, Hall, Room
Reverb Decay 0.1 - 5.0 seconds

Reverb Pre-Delay 0 - 40 ms
Reverb HF Damp Off, 0-20

Rendering a Vocal Air Effect

Applying Air to a lead vocal can help it stand out in a mix. It adds a desirable 
‘airy’ sheen to vocals. 

Vocal Air sets how much “Air” is added to a track in the LR mix. The range is 
Off, 1%-100%. Only the mix is affected, not the individual recorded tracks. 

To render the Air effect into the individual recorded tracks, you must use the 
Bounce feature. 

 L Air can only be applied to one track at a time. If you want to apply Air to a track, 
but it appears grayed out on that track’s Channel screen, and is therefore unavail-
able, you must first turn Air off on the track to which it is currently applied. If you 
want to add Air to multiple vocals, you can use the Bounce feature.

Toggling Phase Inversion

Phase inversion, also known as polarity reversal, can be used to prevent signal 
cancellation when a source is dual-mic’d from opposite directions (e.g. over-
heads on a drum kit) or to compensate for incorrectly wired, balanced cables.
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The Phase setting toggles Phase Inversion on and off.

To toggle a track’s phase inversion:

 X From the Channel screen, tap Phase.

Punching In/Out

Punching allows you to drop in and out of record on armed tracks while playing 
back existing unarmed tracks. Automatic punching is a commonly used tech-
nique that allows you to play along with existing audio and have the record-
er automatically and seamlessly drop into and out of record at predetermined 
points—a cool tool for getting just the right performance. You can punch in/out 
on a new track or over existing tracks. 

Punching in/out over existing material (known as overdubbing) replaces the ex-
isting track audio between the Record In and Out points with new audio. 

To manually punch in/out:

1. Arm the tracks on which you want to punch in/out. 

2. While playing back, at the desired point, press REC to punch in; the MixPre 
will start recording on the armed tracks. The REC control illuminates solid 
red. 

3. Press REC again to punch out; the MixPre will stop recording but continue 
playing back.

To automatically punch in/out:

1. Set Record In and Record Out points to where you want the MixPre to au-
tomatically punch in and out. If a Record In or Out point is set, a ‘P’ is dis-
played in the status bar to indicate that automatic punching is enabled. See 
Working with Cue Points.

2. Use Play In and Stop Q-Points to set pre-roll and/or post-roll as necessary. 
Setting a few bars of pre-roll allows you to play along with existing audio to 
help you get up to speed and ‘into the groove’ before the Record In point. 
Use the Track ‘Monitor’ button to monitor either track playback or your live 
input during pre-roll and post-roll, depending on your preference.

3. Press REC. The transport joystick LED on the 10M (or REC button on the 3M 
and 6M) will illuminate green and the MixPre will start playing from the Play 
In point if set, or from the current playback cursor position if not set. When 
the Record In point is reached, the MixPre will automatically start recording 
on the armed tracks and the joystick LED (or REC button) will illuminate 
red. Recording will continue until the Record Out point is reached (if set) at 
which point the MixPre will return to playback. Playback will stop when the 
Stop point (if set) is reached. 

 L See Working with Cue Points for more information on clearing and disabling Play 
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In, Record In/Out, and Stop points.

Working with Cue Points

The Musician Plugin uses cue points to make it easy to locate quickly to points 
of interest and set up automatic punch in/out regions. 

There are different types:

Icon tyPe DeScrIPtIon

Cue mark  
(01, 02, etc)

Cue marks are cue points that define a specific position of inter-
est within a song, which may be used to “cue” or relocate to that 
point quickly and easily. You may have up to 99 such cues per 
song. For example, set a cue at the start of a verse or chorus. You 
can name cues for easy identification.

Cue marks may also be set as Play In, Record In, Record Out, or 
Stop points. 

Play In Defines when playback begins. Typically used as pre-roll before 
punch in (Record In).

Record In Defines when automatic recording begins (the start of the Punch 
In/Out region).

Record Out Defines when automatic recording ends (the end of the Punch In/
Out region).

Stop Defines when playback stops. Typically used as post-roll after a 
punch out (Record Out).

To add Play In and Record In/Out and Stop cue points:

1. While stopped, tap the Q icon , located at the top of the Home screen. 
The Cue Points menu appears.

 

2. Tap each button (according to icons shown in previous table) to add that 
cue point at current song position. This may be done while stopped, paused, 
or during playback.  
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 L It is not possible to place an In point after an Out point. It is also not possible to 
have more than one In or Out point of each type (Play or Record). 

Alternatively, you can create cue marks and set them as Play In, Record In/Out, 
or Stop points from the Cue-List.

To set a cue marks as a Play In, Record In/Out, or Stop point:

1. From the Cue List, select a cue.

2. Tap Set As. 

3. Tap Play In, Record In, Record Out, or Stop to set the selected cue mark as 
an In/Out point for recording or playback.

Previewing cue marks:

Previewing plays a few seconds of a project from a cue mark. If the cue mark is 
slightly late or early, use the move function to fine tune its position. Previewing 
cue marks is available only within the Musician Plugin.

To preview cue marks:

 X Select one in the Cue List and press Play.

To jump between cue marks:

 X While playing or paused, press in and hold the Play button, and then turn 
the HP encoder to jump to the next or previous cue mark.

Bouncing 

With the Musician plugin, the MixPre offers up to 12 tracks which is enough for 
many situations. For example, four for drums, one for bass, two for vocals, two 
for guitars, two for keyboards plus a spare! 

However, sometimes you may want to add more layers. Bouncing, sometimes 
known as Ping-Ponging, is a technique dating back to the days of the Beatles 
and Beach Boys that allows you to combine multiple tracks into just one or two 
thereby freeing up tracks for further overdubbing. It is also used to simplify 
mixdowns by grouping multiple tracks, or burning in reverb or air effects into an 
ISO track.
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In the MixPre, the bounce mix is derived from the LR mix.

To bounce:

1. Decide to which track(s) you want to bounce. Let’s call these the destination 
tracks.

2. In the destination tracks’ channel screens, set Input to MixL, MixR, or both. 
Your choice will depend on whether you want to do a mono, stereo, or dual 
mono bounce. For instance, if you are doing a stereo bounce to tracks 1 and 
2, set track 1 to MixL and track 2 to MixR. If you are doing a mono bounce 
to track 3, set track 3 to both MixL and MixR. 

 L Any track that is set to MixL or MixR is removed from the LR mix to prevent feed-
back. You can adjust the level of the recorded bounce using the LR gain control - 
tap the L(left) mix meter in the home screen to quickly access LR gain.

3. Decide which track or tracks you want to bounce from. Let’s call these the 
source tracks.

4. Mute all tracks except the source and destination tracks.

5. Disarm all tracks except for the destination tracks.

6. Set the source track levels, pans, reverb and air effects as required. Effects 
are burned in to the destination track(s).

7. You are now ready to bounce.

8. Manually start recording or use auto-punch to begin bouncing from the re-
quired location. As with normal recording, bouncing is a real-time process 
where you can dynamically adjust the source track levels, pans, and effects.

9. Press stop to finish the bounce at any time.

10. Disarm and unroute MixL and MixR from the destination tracks.

11. To hear your bounce, start playback from roughly where the bounce started. 
Adjust mix level, pan, reverb and air accordingly. 

You may want to mute or clear the original source tracks so that you can hear 
your bounce in isolation. 

To clear a track:

1. Access its Channel screen.

2. Tap Input, and then tap Clear.  
Examples: MixPre-3 (left) & MixPre-10T (right) 
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Clear is only displayed if the track contains audio.

 ⚠ Clearing tracks removes them from the project entirely. The files still ex-
ist, but they can only be accessed from a computer.

3. Tap Yes to confirm removal of track audio from the project. 

Metronome

The metronome is an audible click that may be used to help you perform in 
time while recording and also provide a count-in so that you know when to start 
playing. The first beat of the bar is represented by a higher pitched click than 
the other beats of the bar. The metronome click is summed with the LR mix and 
as such can be heard when the headphones or outputs are set to LR.   

The metronome may also be recorded to a track. Select Click in a track’s Input 
screen. 

To set up the metronome:

1. Tap .

2. Tap Metronome, then do any or all of the following:

 L You will hear a preview of the metronome while in this screen.

 X Tap Signature and set the beat (time signature) for the song. Options 
include: 1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4, 8/4, 6/8, 7/8, 9/8.

 X Tap Tempo and set the song tempo (metronome click rate) by tapping 
the arrows or using the HP encoder to adjust the tempo bpm (beats per 
minute) value. Range is 40 to 240 bpm.

 X Tap Volume to set the volume of the metronome click.
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 X Tap Count-in to set the number of count-in bars you want before re-
cording starts. Range is 0 to 8 bars.

 X Tap On During... to set when the metronome is active. Options include: 
Record, Play, or Count-in. 

To enable the metronome:

 X From the Music Control menu, tap the   Metronome button. The Metro-
nome icon will illuminate orange when active.

 L The Metronome button will be disabled (appearing grayed out but with an orange 
icon) whenever Click is assigned as a track’s input source.

Record Settings

With the Musician plugin, the Record submenu provides access to the settings 
detailed in the following table:

Sub-menu DeScrIPtIon oPtIonS

L&R Gain Sets the gain for the LR mix. • -30 - 0 dB (1 dB increment)
 L Tip: You can quickly access L&R Gain by tapping the L (left) horizontal meter 

on the Home screen.

AAC Quality Sets the quality value for AAC rendering.

For more information, see Scroll to and se-
lect the an Audio project folder first, then 
choose a .wav file to import it from within 
the folder..

• 32 kbps
• 64 kbps
• 128 kbps
• 192 kbps
• 256 kbps

To access the Record submenu:

 X Tap , then Record. 

Sharing Projects

Sharing projects is as easy as transferring to a computer and uploading to col-
leagues via the internet or simply handing them an SD card or (on 10T only) a 
USB thumbdrive. 
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There are multiple ways to share a project: 
• Copy Project Folder - ideal for collaborating with other MixPre users. They 

can load the whole project from an SD card and continue working from 
where you left off.

 L Project compatibility is model-specific. For instance, a music project created using 
a MixPre-10M is compatible with another MixPre-10M or any MixPre-10T with the 
Musician plugin. 

• Render a Wav or AAC Stereo File - ideal for sharing your latest mix with 
friends and band members

 L An AAC file is like an .mp3 audio file, except it has better quality for similar bit 
rates.

• Render all individual tracks (also known as ISOs) as monophonic files - ideal 
for importing into a DAW for further production.

To render a project:

1. Tap .

2. Tap Render.

3. Select a format. Options include: 
 ◦ Wav Stereo - performs a real-time render of the LR mix to an uncom-
pressed 2ch stereo wav file. All track level, pan, mute, reverb and air ad-
justments made during rendering are reflected in the resulting stereo wav 
file.

 ◦ AAC Stereo - performs a real-time render of the LR mix to a compressed 
2ch stereo AAC file. AAC files are much smaller in size than a WAV file and 
so are faster to share over the internet. All track level, pan, mute, reverb 
and air adjustments made during rendering are reflected in the resulting 
AAC file. 

 L The bit rate for AAC rendering is set via Main Menu > Record > AAC Quality. Op-
tions for AAC bit rates are: 32, 64, 128, 192, or 256 kbps. The higher the number, 
the better the quality.

 ◦ Wav All Isos - performs a real-time render of all isolated (individual) 
tracks each to their own monophonic wav file. This is the ideal option for 
importing all tracks into a DAW. Just drag them all to zero on your DAW’s 
timeline to sync all of them up perfectly.
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Appendix A

Basic/Advanced Mode Differences

Screen Sub-menu baSIc moDe aDvanceD moDe

Channel Solo - 

Channel Arm - 

Channel Gain - 

Channel Pan L, C, R Continuously Variable
Channel Input - 

Channel Phantom  

Channel Low Cut Fixed 80 Hz 40, 80, 120, 160 Hz
Channel Linking - Stereo, MidSide
Menu Presets  

Menu Project  

Menu Inputs (Aux In) Mic, Line, Off Mic, Line, Camera, Time-
code, Off

Menu Outputs - Stereo out L/R source select, 
Stereo out gain

Menu Timecode  

Menu Tone On/Off On/Off, Continuous/Left 
Identify/Tone Level

Menu Record Rec Trigger LR Linking, L/R Gain, Sample 
Rate, Bit Depth, Rec Trigger

Menu SD Card  

Menu Date/Time  

Menu System  

Menu System > Limiters Always On On/Off
Menu Power  
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System Settings

Page Sub-menu DeScrIPtIon

1 Mode Lets you switch the operating mode between Basic, Advanced and 
Custom.

1 USB-C Switches between Audio and Power Only USB modes.

1 File Transfer Lets you transfer files between the MixPre and a host computer.

1 Limiters Lets you turn limiters on/off (available only in Advanced or Custom 
modes).

2 Bluetooth Switches Bluetooth Smart on/off.

2 Wingman Password Lets you set a password that would be required when connecting 
to the MixPre-3 with the Wingman app.

2 Brightness Lets you independently adjust the brightness of the touch screen 
and the ring LEDs.

2 Version Provides the current firmware version and serial number.

3 Regulatory Provides full Federal Communications Commission (FCC) compli-
ance information specific to MixPre-3.

3 Update Firmware Lets you update the MixPre firmware from a file on the SD card.  
The latest MixPre firmware can be downloaded from the Sound De-
vices website: www.sounddevices.com/support/downloads.
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Specifications

Specifications are subject to change without prior notice.  
 
For the latest information available on all Sound Devices products, visit our 
website at: www.sounddevices.com.

Audio Inputs

name DeScrIPtIon

Frequency Response 10Hz to 40kHz +/- 0.5dB re 1kHz @ 96kHz sample rate

Total Harmonic Distortion 
(THD)

0.005% max (@1kHz, 22-22kHz BW, gain=20dB, -10dBu in)

Equivalent Input Noise 
(EIN)

-130dBV (-128dBu) max (A-weighting, gain=76dB, 150 ohm source impedance)

Inputs • Mic: XLR active-balanced; 4k input Z
• Line: XLR active-balanced; 4k input Z
• Aux/Mic in: 3.5mm TRS, 2-channel unbalanced; 100k input Z
• USB audio: 2 channel
• All inputs fully RF-filtered and overload protected

Gain • Mic input: +6dB to +76dB
• Line input: -20dB to +30dB
• Fader: -inf to +20dB
• Headphone: -inf to +20dB
• Total, Mic-to-recording (max): +96dB
• Aux In (Mic): +10dB to +40dB
• Aux In (Line): -10dB to +20dB
• Total Aux Gain including Fader, Mic-to-recording: +60dB

ADC 32 bit precision; 120dB dynamic range min (A-weighted, gain=10dB, fader=0dB)

Maximum Input Level • Mic XLR: +14dBu (limiters on or off) 
• Line XLR: +40dBu (limiters on or off)
• Aux In (Mic): -10dBu
• Aux In (Line): +10dBu

Limiters • Limiter at all gain stages, range > 40dB. First stage analog, subsequent stages digital

Low Cut Filters 40Hz to 160Hz (adjustable), 18 dB/oct. First stage analog, subsequent stages digital

Microphone Powering • Mic XLRs: 48V via 6.8k resistors, 10mA each
• Mic 3.5mm: 3V @ 3k source Z
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Audio Outputs

name DeScrIPtIon

Stereo Out 3.5mm TRS stereo unbalanced, 500 ohm output Z, +7.8dBu max output level

DAC feeding Stereo Out, 
Headphone Out

32 bit precision; 115dB dynamic range (A-weighted)

Headphone Out 3.5mm TRS stereo unbalanced, for use with any impedance headphones

Output Limiters Digital

Recorder

name DeScrIPtIon

Maximum Record Tracks 5 tracks (stereo mix + 3 ISOs)

Sampling Frequency • 44.1 kHz
• 48 kHz

• 96 kHz

Bit Depth 16, 24

Media Type • Secure Digital Extended Capacity (SDXC)
• Secure Digital High Capacity (SDHC)
• Secure Digital (SD)

Maximum Storage Size 512 GB (SDXC)

Card Format • FAT32 formatted (32GB or less), exFAT for (>32GB), on-board memory card formatting

File Type • WAV (Broadcast Wave File format), with embedded timecode stamp and metadata

USB

name DeScrIPtIon

Audio Interface (USB-C) 5-in/2-out; 44.1 to 96 kHz; 16/24-bit; Class compliant USB 2.0 high speed or ASIO (supplied)

Mass Storage (USB-C) USB 2.0 high speed

Keyboard (USB-A) Text entry and control

Touch Screen

name DeScrIPtIon

Display 1.6-inch, color, sunlight-viewable IPS LCD

Resolution 320x240
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Timecode

name DeScrIPtIon

Modes • Time of Day (file stamped w/current ToD)
• LTC Input (file stamped w/incoming LTC on Aux 3.5mm)
• HDMI TC (file stamped w/incoming TC from HDMI & sample clock slaved from HDMI sam-

ple clock. Only works on specific cameras that support HDMI TC

Frame Rates Auto detects (fps):
• 23.98 (same as 23.976)
• 24
• 25

• 29.97DF
• 29.97
• 30

HDMI TC In From cameras that output timecode over HDMI

Remote Control

name DeScrIPtIon

Bluetooth Smart Wireless control using Wingman app

HDMI Auto-record start/stop trigger from cameras that output record flag over HDMI

Timecode Auto-record start/stop trigger via Aux In timecode

Power

name DeScrIPtIon

AA Batteries • 4x AA sled
• 8x AA sled
• NiMH recommended

L-Mount Batteries 2x L-mount sled for hot-swappable Li-Ion batteries

From Computer Bus-powered via USB-C port. Use either:

• USB-C to USB-C cable (optional)
• MX-USBY: USB-C to dual USB-A Y-cable (included)

AC Adapter • MX-Charge: 15W PSU w/USB-C connector; includes wall adapter plugs for US, UK, Australia, 
and Europe

Environmental 

name DeScrIPtIon

Operation and Storage • Operating: -20° C to 60° C
• Storage: -40° C to 85° C
• 0 to 90% relative humidity (non-condensing)
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Dimensions and Weight 

name DeScrIPtIon

Size (H x W x D) • 1.4 in x 5.68 in x 4.35 in
• 36 mm x 144 mm x 110 mm

Weight • 16.8 oz (unpackaged, without batteries)
• 0.48 kg (unpackaged, without batteries)
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Glossary of Terms 

Arm

Enables a track for recording
GAin

The ratio of output to input level. Gain is relevant at any point in the audio 
signal path where there is a stage of amplification, such as preamplifier, mixer, 
output, headphones.

PAn

The pan controls the spread of a monaural signal in a stereo or multi-channel 
sound field - it is critical to the makeup of the stereo image. Panning adds space 
in a mix through panning the sounds center, left and right.

PhAntom

Phantom power is DC electric power transmitted through a microphone cable to 
operate microphones that contain active electronic circuitry. Most often used as 
a power source for condenser microphones, though many active direct boxes 
also use it.  The MixPre incorporates P48 +48VDC phantom powering, switch-
able on each microphone input.

Low Cut

An active filter that removes frequencies below a specific point.  The MixPre 
incorporates 80, 120, 160, 200 and 240Hz options with a rolloff of 18dB per 
octave, switchable on each microphone input.
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Notes
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Software License

End-user license agreement for Sound Devices MixPre Series Software / Embedded Firmware 

Important Read carefully: 
This Sound Devices, LLC end-user license agreement (“EULA”) is a legal agreement between you (either an 
individual or a single entity) and Sound Devices, LLC for the Sound Devices, LLC software product identified 
above, which includes computer software, embedded firmware, and may include associated media, printed 
materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”). By using, installing, or copy-
ing the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree to the 
terms of this EULA, do not use or install the SOFTWARE PRODUCT. 

Software Product License 
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as 
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 
Grant of license. This EULA grants you the following limited, non-exclusive rights: In consideration of 
payment of the licensee fee, Sound Devices, LLC, as licensor, grants to you, the licensee, a non-exclusive 
right to use this copy of a Sound Devices, LLC software program (hereinafter the “SOFTWARE”) on a single 
product and/or computer. All rights not expressly granted to licensee are reserved to Sound Devices, LLC. 
Software ownership. As the licensee, you own the hardware on which the SOFTWARE is recorded or fixed. 
Sound Devices, LLC shall retain full and complete title to the SOFTWARE and all subsequent copies of the 
SOFTWARE, regardless of the media or form on or in which the original copies may exist. The license is not 
a sale of the original SOFTWARE. 

Copyright
All rights, title, and copyrights in and to the SOFTWARE PRODUCT (including, but not limited to, any im-
ages, photographs, animations, video, audio, music, text, and “applets” incorporated into the SOFTWARE 
PRODUCT) and any copies of the SOFTWARE PRODUCT are owned by Sound Devices, LLC or its suppliers. 
The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you 
must treat the SOFTWARE PRODUCT like any other copyrighted material, except that you may make copies 
as only provided below. You may not copy the printed materials accompanying the SOFTWARE PRODUCT. 
Restrictions on use. Licensee may not distribute copies of the SOFTWARE or accompanying materials to 
others. Licensee may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create de-
rivative works based on the SOFTWARE or its accompanying printed or written materials. 
Transfer restrictions. Licensee shall not assign, rent, lease, sell, sublicense, or otherwise transfer the SOFT-
WARE to another party without prior written consent of Sound Devices, LLC. Any party authorized by Sound 
Devices, LLC to receive the SOFTWARE must agree to be bound by the terms and conditions of this agree-
ment. 

Termination
Without prejudice to any other rights, Sound Devices, LLC may terminate this EULA if you fail to comply 
with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE 
PRODUCT and all of its component parts. 

Limited Warranty 
No warranties. Sound Devices, LLC expressly disclaims any warranty for the SOFTWARE PRODUCT. The 
SOFTWARE PRODUCT and any related documentation is provided “as is” without warranty or condition of 
any kind, either express or implied, including, without limitation, the implied warranties and conditions of 
merchantability, fitness for a particular purpose, or non-infringement. The entire risk arising out of use or 
performance of the SOFTWARE PRODUCT remains with you. 
No liability for damages. In no event shall Sound Devices, LLC or its suppliers be liable for any damages 
whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss 
of business information, or any other pecuniary loss) arising out of the use of or inability to use this Sound 
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Devices, LLC product, even if Sound Devices, LLC has been advised of the possibility of such damages. In 
any case, Sound Devices, LLC’s entire liability under any provision of this evaluation license shall be limited 
to the greater of the amount actually paid by you for the SOFTWARE PRODUCT or U.S. $5.00. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damag-
es, the above limitation may not apply to you. 

Governing Law 

This agreement and limited warranty are governed by the laws of the state of Wisconsin.

FCC & ISED Compliance Statements

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
This device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.                                           FCC Part 15.19 (a) (3)

Changes or modifications not expressly approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.

FCC Interference Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful inter-
ference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can be determined 
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

—Reorient or relocate the receiving antenna.
—Increase the separation between the equipment and receiver.
—Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
—Consult the dealer or an experienced radio/TV technician for help.

FCC & ISED User Statement 

This device complies with FCC and ISED RF Exposure SAR limits exposure limits for general population / 
uncontrolled exposure.

Cet appareil est conforme à la norme FCC et USED RF Exposure SAR limite les limites d’exposition pour la 
population générale / l’exposition incontrôlée.

This Device complies with Industry Canada License-exempt RSS standard(s). Operation is subject to the 
following two conditions: 1) this device may not cause interference, and 2) this device must accept any in-
terference, including interference that may cause undesired operation of the device.

Cet appareil est conforme avec Industrie Canada, exempts de licence standard RSS (s). Son fonctionne-
ment est soumis aux deux conditions suivantes: 1) ce dispositif ne peut pas causer d’interférences, et 2) 
ce dispositif doit accepter toute interférence, y compris les interférences qui peuvent causer un mauvais 
fonctionnement de l’appareil.


